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Quick start guide

How to edit an image and remove color noise
Step 1: Open image

Open Movavi Photo DeNoise and click Browse for Images to choose the image you want to edit.
Other ways to open a picture
How to use zoom and navigation

Step 2: Remove noise

1. Click the Denoise button to open noise removal options.
2. Choose a noise removal preset under Presets. After you've selected a preset, an intensity slider will appear under its
thumbnail. Use this slider if you want to reduce the intensity of the effect.
3. Click Adjustments and use the sliders to further improve the image.
Learn more about noise removal

Step 3: Edit the photo dimensions

The Rotate tab allows you to rotate the image by 90 degrees, mirror the image horizontally or vertically, and straighten out
the horizon.
The Crop tab allows you to cut off the edges of the photo. You can use this to crop the image to the necessary proportions
or focus on the photo's subject.
The Resize tab allows you to shrink the image to the necessary size in pixels. This can be useful for making avatars, or
uploading images to the web.
Learn how to rotate and straighten images
Learn how to crop images
Learn how to resize images

Step 4: Export image

When you're done, click the Export button to save your photo!

Removing trial restrictions

When you first install a copy of Movavi Photo DeNoise, it will be running in trial mode, where you cannot save the edited
images. To be able to use the program to its fullest, you will need to activate it using an activation key that you can purchase
from our official website or any of our partners.
Follow the instructions below to activate your copy of Movavi Photo DeNoise:

Step 1: Buy activation key

1. Click the button below to go to the purchase page and click the Buy Now button there.

2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase
form. IMPORTANT! Be sure to enter a valid e-mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from
support@movavi.com containing your activation key.

Step 2: Open the activation window

1. Open Movavi Photo DeNoise.
2. Open the Help menu and choose Activate Software. The activation window will appear.

Step 3: Enter your activation key

1. Enter the activation key into the corresponding box.
2. Click Activate to complete the activation.

Having problems with activation?

If activation is not working as expected, try the following:
• Make sure that the activation key is entered correctly and is intended for the program you are activating.
• Try activating offline via e-mail.
• Contact us at support@movavi.com and we'll help you solve the problem!

Activating without Internet access

If the computer you have installed Movavi Photo DeNoise on is not connected to the Internet, you can activate the program
via e-mail.

Getting an activation key

You can purchase an activation key from the official Movavi website or from any of our partners. To purchase a digital copy
from the official website, follow the steps below:

Step 1: Go to the purchase page

To open the purchase page for Movavi Photo DeNoise:
• In the Help menu, choose Buy Activation Key, or
• Follow the link below...

Step 2: Choose a license type
• If you plan to use Movavi Photo DeNoise at home, click Buy Now on the purchase page to proceed with buying the
personal license.
• If you plan to use Movavi Photo DeNoise at work, in a government institution, or gain profit in any way, go to the Business
license tab on the purchase page.
After that, you will be redirected to an online store depending on your region and the available payment methods. All of our
vendor partners are secure and completely safe.

Step 3: Fill in your billing details

1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.

Step 4: Get your activation key

After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate
the program.
Activation instructions
Activating without Internet access

If you haven't received your activation key within the hour:
• Check the Spam folder of your mailbox.
• Contact support.

Activating Photo DeNoise

Activating Movavi Photo DeNoise will let you use the program forever and save your photos. Activation requires an Internet
connection to verify your key.
You will need:
• Movavi Photo DeNoise activation key. You should receive your key via e-mail right after your purchase is completed. Don't
have a key? Buy now
• Internet access to verify your key. Don't have Internet access? See this guide on offline activation

Step 1: Open the activation window

1. Launch Movavi Photo DeNoise.
2. Open the Help menu and select Activate Software. The activation window will open.

Step 2: Enter your activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.

If you have entered the key correctly, you should see a message confirming successful activation. Click OK to complete the
activation process and restart the program.

Having problems with activation?
• Check that the activation key is entered correctly and is intended for the program you are activating.
• Try offline activation.
• Contact our support team.

Activating without Internet

Activation requires Internet access to verify your activation key. If you don't have a working Internet connection on the
computer that Movavi Photo DeNoise is installed on, you can activate the program via e-mail using any other computer or
device. You will be asked to send us an automatically generated e-mail and then enter the reply into the program's Activation
window.
You will need:
• Movavi Photo DeNoise activation key. You should receive your key via e-mail right after your purchase is completed. Don't
have a key? Buy now
• A device or another computer that can be used to send and receive e-mail.

Step 1: Open the activation window

1. Launch Movavi Photo DeNoise.
2. Open the Help menu and select Activate Software. The activation window will open.

Step 2: Enter the activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Select the Activate offline option.
3. Click Activate to proceed to the next step.

Step 3: Send an e-mail with the provided information

The next window contains important activation information that you will need to send us via e-mail in order to activate your
program.

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer
or device that you will be sending the e-mail from.
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information
you've copied earlier into the message body and send this e-mail to reg@movavi.com. The activation server will then verify
your activation key and send you an automatic response containing a registration key, which you will need to enter into the
Activation window. You should receive the server's reply within an hour.

Step 4: Enter your registration key

1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.

Once activation is complete, you may be asked to restart the application.

If you're having problems with offline activation:
• Make sure that the keys are entered correctly and are intended for your version of Movavi Photo DeNoise.
• Make sure you have administrator rights on your computer.
• Contact our support team.

Open images

To begin editing an image, you will need to open it in Movavi Photo DeNoise.

Drag-and-drop

Find the necessary image in Windows Explorer and then drag it from Windows Explorer right onto the Photo DeNoise
window.

Browse

On the start screen of Movavi Photo DeNoise, click the Browse for Images button. A Windows Explorer dialog box will
appear. There, choose the file you want to edit and click Open.

Recent file

On the start screen of Movavi Photo DeNoise, click Open last edited file. The thumbnail next to it shows which image was
opened last.

File menu

Open the File menu and choose Open. A Windows Explorer dialog box will appear. There, choose the file you want to edit
and click Open.
See also:
Saving images

Zoom and navigation

Zoom

When you open an image in Movavi Photo DeNoise, it will be fitted to the window size. Use the zoom and navigation tools at
the bottom of the window to set a comfortable view.
Fit to screen – adjusts the zoom level so that the entire image can fit in the window.
Actual size – sets the zoom level to 100%, displaying the image as it is.
Hand tool – to move an image around while zoomed in, click the hand icon and hold the left mouse button to move
the image. Then, click the hand icon again to go back into editing mode. You can also move the image at any time by
holding the right mouse button.
To magnify an image, use the zoom slider at the bottom of the window. You can also zoom in and out using the mouse
wheel. When you zoom in or out, the current zoom level will be displayed to the right of the navigation controls.

Navigation

Now you can sort through entire photo folders and edit their contents on the fly. Use the file navigation buttons at the bottom
of the window:
Go to the previous image in the folder.
Go to the next image in the folder.
Delete the current image.
Click and hold to view the original of this image before editing.

If you have made changes to the file before switching to the previous or next file, you will be asked to save or discard the
changes.

Removing Noise

Digital noise is random variations of brightness or color on the image. Most often, noise appears on photos taken in low-light
conditions. While you can take certain measures to take pictures with less noise, you can also easily remove or reduce noise
after taking the picture.
Quick photography tips
• Use better lighting. No matter what camera you use, your pictures will be clearer if you take them in bright daylight.
• Don't use digital zoom. Unlike optical zoom, it yields poor image quality. Instead, crop the image afterwards.
• Know your camera. Set lower ISO and higher exposure for low-light photos.

Step 1: Open the Denoise tab

Click the Denoise button on the sidebar to open noise reduction options.

Step 2: Choose a preset

1. Under Presets, choose one of the premade noise removal modes. Each has a different strength and noise removal
method. Try a few to see which one works best for your specific image.
2. Once you've enabled a preset, a slider will appear under it. Use this slider to change the intensity of the selected preset,
blending the output image with the original.

Step 3: Use fine adjustments

1. Click the Adjustments button to see fine adjustment options for the selected preset.
2. Use the sliders to further improve your photo.

Light noise: use this to compensate for variations in brightness (Luminance or contrast noise).
Color noise: use this to compensate for random specks of color (Chroma noise).
Intensity: for some presets, you can modify the strength of the noise removal algorythm.
Sharpness: use this to return some detail to the image if it looks too smooth.
* Please note that very high values may cause distortions.
That's it! Don't forget to save your image without noise!

Saving presets

If you find a combination of adjustments that works best for your pictures, you can save it for later use.

Step 1: Choose an existing preset

Under Presets, choose one of the noise reduction methods. This will be the base for your new preset.

Step 2: Modify adjustments

1. Click the Adjustments button to see the fine adjustment options.
2. Use the sliders to reach the desired effect.

Step 3: Save preset

1. At the bottom of the Adjustments section, click Save preset.
2. A dialog box will appear. Enter a name for the new preset.
3. Click Save.

That's it! Your new preset will appear under Presets > Custom presets.
Renaming custom presets
1. Open the list of Custom presets.
2. Right-click the preset that you want to edit and choose Rename Preset.
3. A dialog box will open. Enter a new name for the preset and click Save.
Deleting custom presets
1. Open the list of Custom presets.
2. Right-click the preset that you want to edit and choose Delete Preset.
3. Click Yes in the dialog box to confirm deleting the preset.

Rotate and flip

The Rotate and Flip tab allows you to flip, rotate, and straighten out images with slanted horizon levels. Click the Rotate
button on the right-hand side of the window to open orientation options.

Rotate and flip images

Use the buttons on the Rotate and Flip tab to rotate the image by 90 degrees or to mirror the image.

Rotates your photo 90° counterclockwise

Flips your photo horizontally (left to right)

Rotates your photo 90° clockwise

Flips your photo vertically (upside-down)

Straighten images

A tilted horizon is a frequent problem for both beginner and experienced photographers when shooting from a handheld
camera. This tool allows you to easily correct tilting in your photos, and you won't have to worry about horizon levels when
taking your pictures.
The Angle slider allows you to manually rotate the image up to 45° either way.

Using the Level Tool:

The Level Tool can help you automatically straighten out the image.
1. In your photo, find a straight horizontal or vertical line. This can be the horizon, the side of a building, or any other lines
that are parallel or perpendicular to the horizon.
2. Now, click the Level Tool and trace that line on your image. Once you've traced the line, the image will be automatically
rotated to make that line exactly horizontal or vertical.

Crop

Cropping an image allows you to save it with a different aspect ratio, remove unwanted parts from the edges, and zoom in
on objects inside the image. We recommend that you save a backup copy of the image before cropping, in case you need
the original image later. Click the Crop button on the right-hand side of the window to open the Crop tab.

Step 1: Open the Crop tab

Click the Crop button on the right to open cropping options.

Step 2: Define size

Next, specify the size and proportions that you want. There are several ways to set the size:
Crop frame
A crop frame will be visible over the image. Drag inside the image to draw the cropping rectangle, or move the edges of the
crop frame with your mouse.
Pre-defined sizes
Open the drop-down box and select a suitable size from the list. Here, you can find some commonly used sizes and presets
for quickly changing the proportions of the image.
Manual input
If you need a specific size in pixels, you can manually enter the width and height into the corresponding boxes. To switch
the width and height, click the Invert Proportions icon.
Lock aspect ratio
Selecting this option will maintain the selected width to height proportions. This way, when you change one dimension of the
cropping rectangle (whether by drawing the cropping area or by entering a number for width or height), the other dimension
will change accordingly to keep the selected aspect ratio.

Step 3: Apply changes

Click the Apply button to accept the cropping changes. To discard the changes, click Reset.

Don't forget to save your image!

Resize

Resizing images allows you reduce an image's file size, prepare pictures for uploading to web albums, which often have a
size limit, or prepare web-sized images for blogs and websites.
Tips:
If you intend to make other edits to the photo, it is best that you do them prior to resizing it, since the image quality will then
be preserved better. Also, we recommend that you save a copy of the image before resizing in case you may need it later,
especially if you plan on printing out the image.

Step 1: Go to the Resize tab

On the right-hand panel of the window, click the Resize button to switch to the Resize tab.

Step 2: Enter new dimensions

Select or enter the necessary image size:
• The Fit into box allows you to select from the most common image sizes, as well as presets for printing and exporting
images.
• To enter a custom image size, enter the dimensions into the width and height boxes. You can change the measurement
unit in the box on the right. The default unit is pixels.
• To avoid visual distortions of the image after resizing, keep the Constrain proportions option enabled.

Step 3: Apply changes

Finally, click Apply to resize the image to the specified size. Don't forget to save the image when you're done!

Save images

Step 1: Click the Export button in the bottom right-hand corner or open the File menu and click Save to rewrite the
previous image, or click Save As to save the image under a different name.

Step 2: In the Save File dialog box, choose where you want to save your image.
Step 3: If you want to save the image in a different format, open the Save as type list and select the format you want.
Step 4: Finally, click Save.

Changing image format

Changing an image's format allows you to use your images in a wider variety of situations or compress the images to a
smaller file size. Many websites only allow a limited number of formats for uploading, so having a tool to easily change
image format becomes a must.

Step 1: After you've opened and edited an image, click Export in the bottom right-hand corner of the window. The Save
File dialog box will open.

Step 2: To choose an image format, open the Save as type box and select the format you need.

If the format lists multiple file extensions, such as *.jpg, *.jpeg and others for JPEG, you can type the necessary file
extension in the file name field.
Advanced:
Some formats also allow you to set image quality and compression method. For these formats, click the Options button in
the Save File dialog box to open these options.
JPEG Quality
Drag the slider to the necessary quality level and click OK. Lower quality allows you to compress the image to a smaller file
size, but will probably not look as good.
TIFF Compression
Select the preferred compression method and click OK:
• Uncompressed: no compression method will be used. The image will be much larger in size than its compressed copies,
but uncompressed images with large resolutions may be processed faster by some software.
• PackBits: offers less compression than LZW, but is the most widely supported compression method, especially on Apple
software.
• LZW: compresses the image to about half size.
• ZIP: best for working with 16-bit images and average for 8-bit images.

Step 3: Choose where to save the new file and give your file a name.
Step 4: Click Save.

If you make any edits after saving the file in a different format, you will be working with the new file.

Image size and quality

Even though image files rarely take up more disk space than videos or other media files, a large photo collection can quickly
fill up your hard drive if you save all photos at the maximum size and quality. In this section, you will learn how to manage
image file size.
Image file size is defined by the following properties:
• Image size in pixels
The larger the image, the more pixels it will be made up of, and the more data will need to be stored. The number of pixels
also defines image resolution for printing, and affects the maximum level of detail you can achieve for a print of a certain
size.
To reduce file size, you can resize the image. However, this comes at a cost: the smaller copy will look just as good, but if
you want to print out the image or use it as wallpaper, the smaller file will look considerably worse than its original.
Let's see how much disk space you can save by resizing images. Below are the file sizes for one image (here, you see a
scaled-down preview), and the difference is amazing, resizing a large image to a viewable 800x600 size makes the file size
over a hundred times smaller.
Dimensions

File Size

7899x5924 px

27,6 MB

800x600 px

168 KB

If you want to upload previews of your images to the web, or share photos in web albums, resizing the photos will most likely
be a good idea: the upload times will be faster, and if you have a storage limit, it won't be filled up as fast as if you uploaded
the images at their original size.
Hint:
Don't scale up small, low-quality images.

An image with small dimensions does not have enough data in the file to allow any program to fully restructure the
quality of a larger size image. If you size them up, you will only be wasting disk space without any improvement in quality.

Read our resizing guide
• Image complexity
Image complexity plays a large role in file size. Due to image compression specifics, images with different content but
identical size and format will differ in file size because of the details that will need to be preserved. For example, if you save
a large image of a purely blue background, some compression methods will only need to store which color fills the whole
image, while for a picture of a flower, all the small details will be stored to avoid quality loss.
Note the images below. They are of identical dimensions and are both saved in JPEG format. One image is a photo of a
complex and colorful flower, while the other is a plain blue background. The second image's file size, having to encode less
data, is 48 times smaller than the first! And while you can't simplify your photos to a single color, keep in mind that some
images will naturally have larger file size than others.

425x282 pixels

144 KB

2,98 KB

Format and compression method
A compression method can be seen as a shorthand writing system for image editing software, where it can write all the data
of your image into less space, and then decipher the shorthand to recreate the image on your screen when you open the file.
Most image compression methods do not store all of the image's data pixel by pixel, since it would take significantly more
disk space. Instead, the image compression algorythm finds a way to pack this information by finding identical parts and only
recording those same parts once, or by throwing away some data that it finds less important. Different formats have different
compression methods, and choosing the best format largely depends on the type and purpose of the images.
Lossless formats: some formats can store the image without losing any data, meaning that the quality of the image will not
decrease when you save it. These formats can store the image either at its full size, or use a lossless compression method,
that will pack the image into a smaller file, yet retain the original quality. No matter the compression level, these files are
rather large, but offer the benefit of higher quality and sharper images, which is especially important for text images and
logos.
Common lossless formats: PNG, TIFF, BMP
'Lossy' formats: other formats allow you to save the images into smaller files, but they compress images at the expense of
some quality. For large photos, the trade-off is usually justified, as the human eye will probably not notice the difference at
low compression levels. However, when manually adjusting quality of 'lossy' formats, such as JPEG, it is important not to set
the quality too low to enjoy the image.
The most common 'lossy' format: JPEG
When you change an image's format, note that saving it to a lossless format will not improve its quality, but only preserve the
existing data. Likewise, if you change an image from a lossless format to a 'lossy' one, some data will inevitably be lost to
compression.
Saving files in a different format

Print photos

Printing the image

To print out an image from Movavi Photo DeNoise:
1. Open the File menu and choose Print.
2. Choose the printer you want to use for printing the photo.
3. Click Settings to open the settings for the selected printer. The settings will vary depending on your printer's
software, but generally you can choose paper size, orientation and color options.
4. Choose the number of copies that you want to print. If this is your first time printing a photo, you may want to first
print only one sample copy to make sure you have set up everything right.
5. Click Print to begin printing!

Image printing guidelines

Follow these guidelines to ensure the best possible print quality:
1. Make sure the image is large enough for printing on the selected paper size, and conversely, choose the right paper size
for your images. If you print out small images on large paper, you may find that you can see individual pixels or that the
image is not smooth enough on print. Before taking the photos you want to print, use a camera with a high megapixel count,
make sure that it is set to the highest available quality (some cameras allow you to shoot smaller images than the camera's
maximum size), and provide good lighting conditions to minimize noise.
The larger the original photo, the larger a print size you can afford without losing crispness and quality. The standard for
printing images is to have at least 300 pixels per inch of the photo paper. The following table shows the correlation between
image size and its printed size when printed at 300 pixels per inch (~118 pixels/cm). You can use it to match paper size to
your image size and vice versa.
Camera Megapixels
2
3

Image Size in Pixels
1600 x 1200 px
2048 x 1536 px

Printed Size in Inches
5" x 4"
7" x 5"

Printed Size in Centimeters
13 cm x 10 cm
17 cm x 13 cm

4

2464 x 1632 px

8.2" x 5.4"

21 cm x 14 cm

5
6

2560 x 1920 px
2816 x 2112 px

8" x 6"
9" x 7"

21 cm x 16 cm
24 cm x 18 cm

8
10
12

3264 x 2468 px
3872 x 2592 px
4000 x 3000 px

11" x 8"
12.1" x 9.1"
13" x 10"

28 cm x 21 cm
33 cm x 22 cm
34 cm x 25 cm

If you didn't find the necessary size in the table, you can easily calculate the printed size in inches by dividing the width and
height in pixels by 300. Likewise, to find out the minimum number of pixels for a certain print size, multiply the width and
height in inches by 300 to get the image dimensions in pixels.
2. You do not need to downsize the image before printing: the software will automatically fit the image onto the selected
paper size. Downsizing the image will only reduce quality.
3. If you need to crop unwanted parts of the image, make sure that the end result is not too small. If you have a very large
image, you can use the crop function to zoom in on objects in the image, but keep in mind that the output image size must
be large enough for printing. You can check the image size in pixels by clicking the File Information button on the bottom
panel:

.

4. Use a high quality printer for printing out your photos. These simple guidelines will help you choose a printer:
• Inkjet printers are much better at printing images than laser printers. Dye sublimation printers are considered the best for
printing photos, however they are quite rare and can only be used for photo printing.
• Check the printer's dots per inch (DPI) resolution: the higher the DPI, the higher quality prints it will be able to produce. For
photo printing, make sure that the printer has at least 300x300 DPI.
• Generally, a dedicated photo printer will produce better results than a general-purpose multifunction printer of the same
price range.
• Some printers may produce colors different from the original because of the way they convert RGB color (the color
scheme you see on your monitor) to CMYK color (used for printing).
•

Be aware of your printer's maximum print size; many consumer printers only print photos up to 8 by 10 inches (20.32 x
25.4 cm). You should find this information on the packaging or in the printer's user manual.
5. Use high quality photo paper. There are different kinds of photo paper that may work differently depending on the content
of your image. For example, glossy paper is better at reproducing bright colors, while matte paper is more suitable for
portraits. Also, make sure that the paper matches your printer type (i.e. laser or inkjet).

Calibrating your Display

The colors you see in print may be slightly different than those you see on your display due to LCD monitor specifics. You
can try to calibrate your display for better previewing:
1. Open the Control Panel.
2. Type "Calibrate display" into the search box.
3. Click Calibrate display color. This requires administrator permissions.
4. Follow the onscreen instructions to calibrate your display.

Help and support

If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team.
Write to us at suppport@movavi.com
or click the button on the right to ask a support specialist via live chat.
Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our
support team specialists may ask you for additional information that is required to solve your problem: these may include
your license key, log files, and files you were working with, but never personal information. We value your privacy!
Have you checked the FAQ section?
Your question may have already been answered!
More questions:
How to activate Movavi Photo DeNoise
How to buy the software
How to update the graphics card drivers

Supported formats
Format
BMP
DPX
EXR
GIF (Non-animated)
JPEG
JPEG 2000
JPEG-LS
PAM
PCX
PGM
PNG
PBM
PPM
SGI
Sun Rasterfile
TARGA
TIFF
WebP
XBM
XFace
XWD

Open

Save

System requirements

The minimum system requirements represent the lowest hardware specifications that are guaranteed to run Movavi Photo
DeNoise. If your computer meets the recommended configuration, then Movavi Photo DeNoise is sure to run smoothly
on your comptuer. Movavi Photo DeNoise may also run on slower machines, however, we cannot guarantee stable
performance if the minimum requirements are not met.

Minimum system requirements
Operating system
Processor
Display resolution

Recommended configuration

Windows® Vista/7/8/10 with latest service packs and patches
Intel®, AMD® or compatible
2.2 GHz
processor, 1 GHz
1024x768, 32-bit color
1280x1024 or higher

RAM

Windows Vista – 256 MB
Windows 7, 8, 10 – 1 GB

4 GB

Available disk space

150 MB required for installation

500 MB recommended for ongoing
operations

Updating graphics card drivers

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from
your graphics card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility
that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers
up-to-date will ensure stable performance of applications and games on your computer.

Step 1: Find your graphics card manufacturer

1. Right-click your desktop and choose Screen Resolution.
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the
Adapter Type section. Note the full name of the graphics card somewhere for later.

Step 2: Download the new version

Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver
downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some
manufacturers may also offer a utility that will automatically find the necessary driver.
NVIDIA download center
AMD download center
Warning:
Only download drivers from the official manufacturer's website. Thirdparty websites offering driver downloads may contain malware.

Step 3: Install driver

Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on
your system. Your display may blink several times in the process. After the installation has finished, it is advised that you
restart the computer.

Updating NVIDIA® Driver

Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver
updates and allows you to optimize your computer's graphics performance.
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the
application, please try the method above.
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will
automatically download and install the necessary driver for your system.

Updating AMD® or ATI® Driver
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
2. Download the auto detect utility and run it when the download has finished.
Auto Detect Utility
3. The utility will then automatically find your graphics card and help you download and install the right driver for your
system.
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the
Driver Downloads page and download the driver.
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5. After the driver has been installed, it is recommended that you restart your computer.
If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages
you have encountered. This will help our support team specialists solve your problem quicker.

